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DPD Graduate Seminar Syllabus Fall 2023
NTDT 50101

COURSE TITLE & NUMBER: NTDT 50101 DPD Graduate Seminar
CREDIT HOURS: 1 Semester Hour
LECTURE INSTRUCTOR: Rebecca Dority, MS, RD, LD, CDCES

Bass 1201J (office); (817) 257-6322; r.dority@tcu.edu

CLASS LOCATION: Bass 1201 — Nutritional Sciences Conference Room

CLASS MEETING DAYS & TIMES: TBD

OFFICE HOURS: By appointment

COMMUNICATION POLICY: Instructor will respond to emails at ~10:00 am and ~4:00 pm
central time, daily, Monday through Friday. Emails received over the weekend will be answered on
Monday.

COURSE PREREQUISITES: Graduate status in the Department of Nutritional Sciences MS in
Nutrition with DPD Verification.

FINAL EVALUATIVE EXERCISE: Final DICAS application due

COURSE DESCRIPTION: This course consists of seminar topics that introduce professional practice
expectations in nutrition and dietetics, leadership and career skills, and the supervised pratice application
process. This course is designed for students pursuing Didactic Program in Dietetics (DPD) verification
required for advancement to an accredited supervised practice program and subsequent eligibility to take the
Registration Examination for Registered Dietitian Nutritionists.

COURSE OBJECTIVES:

NTDT 50101 DPD Graduate Seminar meets learning objectives for Core Knowledge for the Registered
Dietitian Nutritionist (KRDN) required by the Accreditation Council for Education in Nutrition and
Dietetics (ACEND).

ACEND REQUIRED CORE KNOWLEDGE FOR THE RDN:

o Professional Practice Expectations: Beliefs, values, attitudes and behaviors for the nutrition and
dietetics practitioner level of practice.

o KRDN 2.2 Describe the governance of nutrition and dietetics practice, such as the Scope of
Practice for the Registered Dietitian Nutritionist and the Code of Ethics for the Profession of
Nutrition and Dietetics.

o KRDN 2.6 Demonstrate cultural humility, awareness of personal biases and an
understanding of cultural differences as they contribute to diversity, equity and inclusion.

o KRDN 2.7 Describe contributing factors to health inequity in nutrition and dietetics
including structural bias, social inequities, health disparities and discrimination.
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o KRDN 2.8 Participate in a nutrition and dietetics professional organization and explain the
significant role of the organization.

e Leadership and Career Management: Skills, strengths, knowledge and experience relevant to
leadership potential and professional growth for the nutrition and dietetics practitioner.

o KRDN 5.1 Perform self-assessment that includes awareness in terms of learning and
leadership styles and cultural orientation and develop goals for self-improvement.

o KRDN 5.2 Identify and articulate one’s skills, strengths, knowledge and experiences
relevant to the position desired and career goals.

o KRDN 5.3 Practice how to self-advocate for opportunities in a variety of settings (such as
asking for needed support, presenting an elevator pitch).

o KRDN 5.6 Demonstrate an understanding of the importance and expectations of a
professional in mentoring and precepting others.

COURSE REQUIREMENTS:
This course currently meets all or part of the following requirements for a degree:
e TCU Core Curriculum Requirement(s): None
e Requirement within the Major: Required for all NTDT graduate students in the Didactic Program
in Dietetics (DPD)
e Requirement for other Majors: None
e Supports Mission Statement: Supports departmental, college, and university Mission Statements

DESCRIPTION OF TEACHING METHODS/LEARNING EXPERIENCES: The course instructional
methodology will include activities, lectures, discussions, TCU Online assignments, and field
assignments.

TEACHING PHILOSOPHY: It is the desire of the faculty in the Department of Nutritional Sciences
(NTDT) to help students achieve their fullest potential in acquiring knowledge and developing skills for
professional applications in nutrition and dietetics practice. Providing students with access to a wide
variety of learning experiences supports different learning styles and creates an opportunity for individual
discovery and synthesis of knowledge related to the science of nutrition. The role of the NTDT faculty is
to provide students with tools that foster self-discovery and professional development, result in the
acquisition of knowledge from evidence-based research, and cultivate life-long learning.

REQUIRED AND RECOMMENDED READINGS/EQUIPMENT:

e Academy of Nutrition and Dietetics: Revised 2017 Scope of Practice for the Nutrition and Dietetics
Technician, Registered. https://doi.org/10.1016/j.jand.2017.10.005

o NDEP Applicant Guide for Supervised Practice (available in D2L)

e Various readings/websites as recommended in class

COURSE POLICIES AND REQUIREMENTS
ASSIGNMENTS:

1. Self-Assessment and Goal Setting Evaluation: Students will complete a formative self-evaluation
to assess their individual learning, leading, and cultural orientation. Students will set two measurable
goals to achieve this semester. A goal achievement reflection is due during final exam week. This
assignment satisfies KRDN 5.1.
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2. ACEND DEI Training Webinars and Written Reflection: Students will watch required webinars
related to cultural humility, awareness of personal biases, and health inequities then complete a
written reflection of these factors as they relate to the practice of nutrition and dietetics. This
assignment satisfies KRDN 2.6 and KRDN 2.7.

3. Clifton Strengths Assessment: Students will complete a Clifton Strengths assessment and
subsequent individual conference session with the TCU Leadership Center.

4. Networking Activity: Students will work independently to complete the assignment to assist in
successfully navigating networking opportunities. This assignment partially satisfies KRDN 5.3.

5. Compensation Negotiation Activity: Students will work individually and in groups to apply critical
thinking skills to a role-play case scenario in which the practitioner must negotiate compensation.
This assignment partially satisfies KRDN 5.3.

6. Supervised Practice Selection Write Up: Students are required to investigate supervised practice
programs and consider academic and career options if a match is not made.

7. Professional Meeting Reflection: Students will attend 1 professional meeting (in person or virtual)
and complete the reflection papers, including topics as listed in the assignment. This assignment
satisfies KRDN 2.8.

8. Mentorship Plan and Reflection: Students will work as a group to develop a mentorship program in
which DPD students enrolled in NTDT 50101 will serve as mentors for NTDT students who wish to
apply to the dietetics programs at TCU. This assignment satisfies KRDN 5.6.

9. LinkedIn Update: Students will create/update personalized LinkedIn profile.

10. IPE Debrief: Students will attend the required centralized IPE session and complete the reflection
paper, including topics as listed in the assignment.

11. Resume and Personal Statement: Students complete drafts of their resume and personal statements
to be included in their DICAS application. This assignment satisfies KRDN 5.2,

12. Final DICAS Application: Students will complete a draft DICAS application to be used for
supervised practice application submission.

Course Activities & Your Points  Total Impact on Final Course Grade
Course Grade
Self-Assessment and Goal Setting 40 6%
Evaluation
ACEND DEI Training Webinars and 40 6%
Written Reflection
Clifton Strengths Assessment 25 4%
Networking Activity 25 4%
Compensation Negotiation Activity 25 4%
Supervised Practice Selection Write 25 4%
Up
Professional Meeting Reflection 25 4%
Mentorship Plan and Reflection 100 16%
LinkedIn Update 25 4%
IPE Debrief 50 8%
Resume 50 8%
Personal Statement 100 16%
Final DICAS Application 100 16%
TOTAL | 630

Page 3





METHOD OF STUDENT EVALUATION/GRADING:

+/- GRADING SCALE:

Grade Score Grade Score Grade Score

A 94-100 B 84-86.99 C 74-76.99
A- 90-93.99 B- 80-83.99 C- 70-73.99
B+ 87-89.99 C+ 77-79.99 F 0-69.99

SPELLING AND GRAMMAR:

Correct spelling and grammar are expected for ALL course assignments and activities and required for
full points. Submitted work which includes improper spelling or grammar will receive a grade deduction
as specified on the associated grading rubric or as deemed appropriate relative to total point available for
the assignment.

MISSED ASSIGNMENTS/LATE WORK:

Students may make up assignments that they miss due to Official University Absences, serious illness, or
family-related emergencies verified by The Dean of Students Office (formerly known as Campus Life) or
at the discretion of the instructor. A written doctor’s note does not excuse a missed assignment. Students
will incur a 10% grade deduction on the assignment for each day that the assignment is submitted late.

PARTICIPATION/ENGAGEMENT (ATTENDANCE):

Participation in all in-person course activities is mandatory and will be enforced. Students who miss an
instructional experience are expected to meet with faculty to discuss their absence as soon as possible.
There will not be an option for students to participate in lecture activities online.

CLASS NORMS & NETIQUETTE:

All members of the class are expected to follow rules of common courtesy in all email messages,
discussions, and chats. If I deem any of them to be inappropriate or offensive, | will forward the message
to the Chair of the department and appropriate action will be taken, not excluding expulsion from the
course. The same rules apply online as they do in person. Be respectful of other students. Foul discourse
will not be tolerated. Please take a moment and read some basic information about netiquette
(http://www.albion.com/netiquette/).

Participating in the virtual realm, including social media sites and shared-access sites sometimes used for
educational collaborations, should be done with honor and integrity. Please review TCU’s guidelines on
electronic communications (email, text messages, social networks, etc.) from the Student Handbook.
(https://tcu.codes/policies/network-and-computing-policy/e-mail-electronic-communications-social-
networks/)

TECHNOLOGY POLICIES:

Email:
Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

Course Materials:

TCU students are prohibited from sharing any portion of course materials (including videos, PowerPoint
slides, assignments, or notes) with others, including on social media, without written permission by the
course instructor. Accessing, copying, transporting (to another person or location), modifying, or
destroying programs, records, or data belonging to TCU or another user without authorization, whether
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such data is in transit or storage, is prohibited. The full policy can be found
at: https://security.tcu.edu/polproc/usage-policy/.

Violating this policy is considered a violation of Section 3.2.15 of the Student Code of Conduct (this
policy may be found in the Student Handbook at https://tcu.codes/code/index/), and may also constitute
Academic Misconduct or Disruptive Classroom Behavior (these policies may be found in the
undergraduate catalog at https://tcu.smartcatalogig.com/current/Undergraduate-Catalog/Student-
Policies/Academic-Conduct-Policy-Details). TCU encourages student debate and discourse; accordingly,
TCU generally interprets and applies its policies, including the policies referenced above, consistent with
the values of free expression and First Amendment principles.

ACADEMIC MISCONDUCT:

Academic Misconduct (Sec. 3.4 from the TCU Code of Student Conduct): Any act that violates the
academic integrity of the institution is considered academic misconduct. The procedures used to resolve
suspected acts of academic misconduct are available in the offices of Academic Deans and The Dean of
Students Office (formerly known as Campus Life) and are also listed in detail in the Undergraduate
Catalog and the Graduate Catalog Specific examples include, but are not limited to:

e Cheating: Copying from another student’s test paper, laboratory report, other report, or computer
files and listings; using, during any academic exercise, material and/or devices not authorized by
the person in charge of the test; collaborating with or seeking aid from another student during a
test or laboratory without permission; knowingly using, buying, selling, stealing, transporting, or
soliciting in its entirety or in part, the contents of a test or other assignment unauthorized for
release; substituting for another student or permitting another student to substitute for oneself.

e Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s work, and the
unacknowledged submission or incorporation of that work as one’s own offered for credit.
Appropriation includes the quoting or paraphrasing of another’s work without giving credit
therefore.

e Collusion: The unauthorized collaboration with another in preparing work offered for credit.

e Abuse of resource materials: Mutilating, destroying, concealing, or stealing such material.

e Computer misuse: Unauthorized or illegal use of computer software or hardware through the
TCU Computer Center or through any programs, terminals, or freestanding computers owned,
leased or operated by TCU or any of its academic units for the purpose of affecting the academic
standing of a student.

o Fabrication and falsification: Unauthorized alteration or invention of any information or
citation in an academic exercise. Falsification involves altering information for use in any
academic exercise. Fabrication involves inventing or counterfeiting information for use in any
academic exercise.

e Multiple submission: The submission by the same individual of substantial portions of the same
academic work (including oral reports) for credit more than once in the same or another class
without authorization.

e Complicity in academic misconduct: Helping another to commit an act of academic
misconduct.

o Bearing false witness: Knowingly and falsely accusing another student of academic misconduct.

TCU ONLINE: OUR LEARNING MANAGEMENT SYSTEM
GETTING STARTED WITH TCU ONLINE:

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)
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Log In: (using your TCU Network Credentials)

1. Access via my.tcu.edu > Student Quick Links > TCU Online

2. Login at the following website (http://d2l.tcu.edu) my.tcu.edu
*For information about logging into TCU Online, view these instructions.
(http://tcuonline.tcu.edu/kb/how-do-i-log-in/).

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online Student
Orientation Tutorial, please do so now. To access it, click on the Orientations semester OR view all
courses in your My Courses widget visible upon logging in to TCU Online. Click on the "Student
Orientation Tutorial” to enter the orientation course. Follow the instructions in the course. You can return
to this tutorial at any time.

How This Course Will Use TCU Online: TCU Online will be used extensively throughout this course,
including, but not limited to: course announcements; course lecture notes and associated documents,
handouts and videos; calendars; quizzes; assignments; exams; and labs. Students should access the
course TCU Online course pages for both lecture and lab on a regular basis throughout the semester.

Getting Help with TCU Online:
If you experience any technical problems while using TCU Online, please do not hesitate to contact the
D2L HELP DESK. They can be reached by phone or chat 24 hours a day, 7 days a week, 365 days a year.
Phone: 1-877-325-7778
Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the helpdesk to resolve a technical issue, make sure to keep me updated on the
troubleshooting progress. If you have a course-related issue (course content, assignment troubles,

quiz difficulties) please contact me.

Personal Settings & Notifications for TCU Online:

As a student, you should set up your account settings, profile, and notifications. To do this you will login
to TCU Online and select your name on the top right of the screen. You can upload a photo of yourself
and add personal information to your profile. In the notifications area, you can add your phone number to
receive text messages when grades are given, as well as reminder texts for upcoming assignments and
quizzes.

Student Success Tools for TCU Online:

Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the number of
assignments and events on the course calendar for your classes, the graph will display busy times for class
work in the upcoming week. You can use this app to manage your daily workload, and it includes the
ability to view and access course materials offline. You can download Pulse from the Google Play or
Apple Store. You can learn more and download Pulse here:_https://www.d2l.com/products/pulse/.

ReadSpeaker

ReadSpeaker includes a number of tools that can enhance your understanding and comprehension of
course materials. ReadSpeaker can create an audio version of content that you can listen to while on a
page within a course or that you can download to listen offline. ReadSpeaker can also read Microsoft
Office files and PDFs. There are additional tools and features to assist you with reading and focusing in
TCU Online, tools that provide support for writing and proofing text, and tools that can read non-TCU
Online content aloud. You can learn more about how to use ReadSpeaker tools here:
https://tcuonline.tcu.edu/how-to-hub/instructor-how-to-hub-for-tcu-online/integrations-and-
mobile/readspeaker/
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SUPPORT FOR TCU STUDENTS

CAMPUS OFFICES:
e Academic Advising (817-257-7486, Jarvis 104)

Brown-Lupton Health Center (817-257-7938 or 817-257-7940)
Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
Center for Writing (817-257-7221, Reed Hall 419)
Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2" floor)
Dean of Students (817-257-7926, the Harrison 1600)
Mary Couts Burnett Library: Reference Desk (817-257-7117)
Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1% floor)
Student Access & Accommodations (817-257-6567, The Harrison 1200)
Student Success (817-257-8345, Samuelson Hall, West Entrance)
Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2" floor)
Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
Veterans Services (817-257-5551, Jarvis Hall 2™ floor)

ANTI-DISCRIMINATION AND TITLE IX INFORMATION:

Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from unlawful
discrimination, harassment, sexual misconduct, and retaliation. In support of this commitment, in its
policy on Prohibited Discrimination, harassment, sexual misconduct and retaliation, TCU has a range of
prohibited behaviors, including unlawful discrimination and harassment and related sexual and other
misconduct based on age, race, color, religion, sex, sexual orientation, gender, gender identity, gender
expression, national origin, ethnic origin, disability, predisposing genetic information, covered veteran
status, and any other basis protected by law. The Office of Institutional Equity (OIE) is responsible for
responding to all reports of discrimination, harassment, sexual misconduct and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment,
Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to Reports of Prohibited
Discrimination, Harassment, Sexual Misconduct, and Retaliation.

To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The Harrison, Suite
1800 or click here: Make a Report.

To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident click here:
https://inclusion.tcu.edu/campus-community-response-team/

Title IX

TCU’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU’s Title IX
Coordinator. You may call 817-257-8228 to make a report, email ocie@tcu.edu or a.vircks@tcu.edu, or
make a report here. Additional Title X resources and information are available at
https://www.tcu.edu/institutional-equity/title-ix/index.php.

Mandatory Reporters

ALL TCU employees, except confidential resources, are considered Mandatory Reporters. Mandatory
reporters are required to immediately report to OIE any conduct that raises Discrimination, Harassment,
Sexual Misconduct (Title IX or Violence Against Women (VAWA)) or Retaliation. Mandatory reporters
cannot promise to refrain from forwarding the information to OIE.
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Confidential On-Campus Resources
Campus Advocacy, Resources & Education
www.care.tcu.edu | 817-257-5225

Counseling & Mental Health Center
www.counseling.tcu.edu | 817-257-7863

Religious & Spiritual Life

www.faith.tcu.edu | 817-257-7830

On Campus Resources

TCU Police

www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays

“Students who are unable to participate in a class, in any related assignment or in a university required
activity because of the religious observance of a holy day shall be provided with a reasonable opportunity
to make up the examination or assignment, without penalty, provided that it does not create an
unreasonable burden on the University.” For more information, please visit the TCU Policy for Religious
Observations & Holidays webpage.

Student Access and Accommodation

Texas Christian University affords students with disabilities reasonable accommodations in accordance
with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act. To be eligible for
disability-related academic accommaodations, students are required to register with the TCU Office of
Student Access and Accommaodation and have their requested accommodations evaluated. If approved for
accommodations, students are required to discuss their official TCU Notification of Accommodation with
their instructors. Accommodations are not retroactive and require advance notice to implement. The
Office of Student Access and Accommodation is located in The Harrison, Suite 1200. More information
on how to apply for accommodations can be found at https://www.tcu.edu/access-accommodation/ or by
calling Student Access and Accommaodation at (817) 257-6567.

Audio Recording Notification:

Audio recordings of class lectures may be permitted by the instructor or as an approved disability
accommodation through Student Access and Accommodation. Recordings are not to be shared with other
students, posted to any online forum, or otherwise disseminated.

EMERGENCY RESPONSE INFORMATION

Please review TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek
Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/)

TCU’s Public Safety website provides maps that show our building’s rally point for evacuation and the
seek shelter location. (https://publicsafety.tcu.edu/)
In the event of an emergency, call the TCU Police Department at 817-257-7777.

Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/).

COURSE SCHEDULE

This calendar represents my current plans and objectives. As we go through the semester, those plans may
need to change to enhance the class learning opportunities. Such changes will be clearly communicated.
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Preparation / Reading
Assignment
(Other than the course

text, all reading is
located within the

module)

Learning Activity

Week 1 DPD Policies and Read: Policies in the DPD | Review policies, expectations,
Aug 21 Handbook Handbook and sign related documents
Review: Course Syllabus | Special Event: ALL-NTDT
and Outline meeting Tuesday, Aug 22
Week 2 Self-Assessment and Intr_oductiop to mentorship
Aug 28 .- assignment; Introduction to
Goal Setting; ACEND DEI webinars
Mentorship
Week 3 No class - Labor Day
Sept 4
Week 4 Scope of Practice for Read: Scope of Practice Participate in Scope of Practice
Sept 11 the Registered documents and Code of Discussion
Dietitian Nutritionist Ethics Mentorship Plan due 9/11 1:00
pm
Week 5 New DICAS Format; Preview: DICAS website | Review new DICAS computer
Sept 18 Computer Matching (create log in/password) software; Using the Applicant
Finding the Right Guide and other tips
Internship “Match”; Self-Assessment Assignment
Applicant Guide due 9/18 1:00 pm
Week 6 DI Application Review: Current Resume | Review purpose and tips for
Sept 25 Process: Personal and Personal Statement writing personal statements and
Statements and (bring to class); schedule resumes
Resume Writing Clifton Strengths ACEND DEI Webinar
assessment Reflection due 9/25 1:00 pm
Week 7 Networking Watch: Networking video | Participate in Networking
Oct 2 Activity
Week 8 Resume and Personal Independent work on resume
Oct 9 Statement Workshop and personal statement
Networking Activity due 10/9
1:00 pm
Week 9 Using Social Media Professionalism and social
Oct 16 for Supervised media
Practice Applications
Week 10 Compensation Participate in Compensation
Oct 23 Negotiation Negotiation Activity
LinkedIn Update due 10/23
1:00 pm
Week 11 DICAS Workshop 1:00 pm: Independent work on
Oct 30 DICAS
Compensation Negotiation
Activity due 10/30 1:00 pm
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Preparation / Reading
Assignment

(Other than the course Learning Activity

text, all reading is
located within the

module)
Week 12 Clifton Strengths Review: Clifton Strengths | Review Clifton Strengths results
Nov 6 Results and how to incorporate into
personal statement
Supervised Practice Selection
Write Up and Clifton
Strengths Assessment due Nov
61:00 pm
Week 13 Personal Statement Independent work on personal
Nov 13 Workshop statement
IPE Debrief due Nov 13 1:00
pm
Week 14 THANKSGIVING BREAK
Nov 20
Week 15 Requesting Letters of | Review: Rec letter form Review guidelines for requesting
Nov 27 Recommendation; and requirements letters of recommendation;
Interviewing Interview tips
Personal Statement due Nov
27 1:00 pm
Week 16 Semester Wrap Up Individual meetings to discuss
Dec 4 resume and personal statement
Mentorship Reflection due and
Professional Meeting
Reflection due 12/4 1:00 pm
Week 17 Final Exam Week Final DICAS Application Due
Dec 11 12/11 1:00 pm

STUDENT PERCEPTION OF TEACHING (SPOT): Towards the end of the term you will receive an
email asking you to complete your SPOT for this course. | appreciate your thoughtful and reflective
feedback to help make this course successful for future students. You can fill out the SPOT by clicking on
the link in the email or in TCU Online when SPOTs open.

TCU MISSION STATEMENT: To educate individuals to think and act as ethical leaders and
responsible citizens in the global community through research and creative activities, scholarship, service,
and programs of teaching and learning offered through the doctoral level.
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File attachment on: 2022/12/16 08:35:06


Description of new course (catalog copy): include an attachment if additional space is needed

This course consists of seminar topics that introduce professional practice expectations in nutrition and dietetics, leadership
and career skills, and the supervised pratice application process. This course is designed for students pursuing Didactic
Program in Dietetics (DPD) verification required for advancement to an accredited supervised practice program and
subsequent eligibility to take the Registration Examination for Registered Dietitian Nutritionists.

Cilhs e o aitme n 2l attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments




Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed

Student learning outcomes for students pursuing Didactic Program in Dietetics (DPD) verification will
be reported to the Accreditation Council for Education in Nutrition and Dietetics (ACEND). Students
enrolled in this course prepare their application for supervised practice which is required for eligibility
to take the Registration Examination for Registered Dietitian Nutritionists. DPD program outcomes
related to student placement in supervised practice will be reported to ACEND annually.

attached files can be seen and managed in Acrobat Pro by clicking on

Sliele nsre b9 gl @il View > Show/Hide > Navigations Panes > Attachments

Additional resources required:

Faculty: N/A - Course will be taught by the current Didactic Program in Dietetics Director
Space: N/A

Equipment: N/A

Library: N/A

Financial Aid: N/A

Other: N/A

Change in teaching load: N/A

Does this change affect any other units of the University? Yes || No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Gina Jarman Hill

Unit: NTDT

. ) . : Digitally signed by Gina Jarman Hill
signawre: G1NA Jarman Hill Date: 2022.12.19 13:04:59 -06'00"
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